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WORKING WITH WINDOWS 10

A.	 Tick ( ) the correct option.
1.		 Which of the following option is used to recover a file?

a.	 Recycle	 	 b.	 Restore	

c.	 Delete	 	 d.	 Save	

2.	 Which folder is used to store the files that are downloaded from Internet?

a.	 Documents	 	 b.	 Downloads	

c.	 Subfolder	 	 d.	 Picture	

3.	 A deleted file goes into …………….…. .

a.	 Documents	 	 b.	 Downloads	

c.	 Recycle Bin	 	 d.	 This PC	

B.	 Identify the below icons and write their names.

	 		  	 	 		

1.  	 ………………	 2.	 ………………	 3. 	 ………………	 4.	 ………………

C.	 Fill in the blanks using the hints given below:
Hints: This PC, Icon, File 

1.	 ………………….…. contains a collection of related information.

2.	 ………………….…. represents a file in a computer.

3.	 To open file explorer, you can click on ………………….…. icon.
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WORKING WITH WINDOWS 10

A.	 Guess who am I?
1.	 I am a shortcut key to cut a file or folder.� ………….

2.	 I store all the deleted files.	�  ………….

3.	 I am a folder to store all your digital pictures.� ………….

B.	 Label the steps to create a new folder.

C.	 Answer the following questions:
1.	 What is a subfolder?

	 ………….…………………….………….………….…………………….…………

b.	 What is File Explorer?

	 ………….…………………….………….………….…………………….…………

c.		 Write a difference between cutting a folder and copying a folder.

	 ………….…………………….………….………….…………………….…………
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PAGE FORMATTING AND MAIL MERGE IN WORD 2016

A.	 Tick ( ) the correct option.
1.	 Which of the following is used to create address list?

a.	 Address Block	 	 b.	 Type New List	

c.	 Address List	 	 d.	 None of these	

2.	 …………….…. is the text that appears at the top of each page of the document.

a.	 Header	 	 b.	 Blank	

c.	 Footer	 	 d.	 None of these	

3.	 A header is printed in the …………….…. margin.

a.	 top	 	 b.	 side	

c.	 bottom	 	 d.	 middle	

B.	 Label the steps to insert header and footer in a word document.

C.	 Fill in the blanks using the hints given below:
	 Hints: Layout, Page margin, Enter key, Letters

1.		 Size command is found in …………….….  tab.

2.	 …………….…. is white space all around the printed area of a paper. 

3.	 …………….…. is the command used for creating Mail Merge. 

4.	 …………….…. creates a new paragraph.
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A.	 Write ‘T’ for true and ‘F’ for false.
1.	 By default, MS Word document is written into a single column.� ………….

2.	 Write & Insert Fields group is present under Home tab.� ………….

3.		 Footer is the text that appears at the top of each page of  
the document.� ………….

B.	 Guess who am I?
1.	 I am a shortcut key to insert a column break.			   ………….

2.	 I am used to align the text.					     ………….

3.	 I am the text that appears at the top of each page of the document.	 ………….

4.	 I am a feature in MS Word used to create personalized letters.	 ………….

C.	 Answer the following questions:
1.	 What is Tab Stop?

	 ................................................................................................................................................................

2.	 What is indentation?

	 ................................................................................................................................................................

3.	 Name two orientation of MS Word.

	 ................................................................................................................................................................

4.	 What is use of tabs in MS Word?

	 ................................................................................................................................................................
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ENHANCING A PRESENTATION

A.	 Label the components of the chart of the PowerPoint.

B.	 Tick ( ) the correct option.

1.	 Which tab is used to create a table in PowerPoint? 

a.	 Home	 	 b.	 Format	

c.	 Insert 	 	 d.	 None of these	

2.	 The intersection of a row and a column in a table is called a ………….. 

a.	 Cell	 	 b.	 Row	

c.	 Table 	 	 d.	 Column	

C.	 Answer the following questions:

1.	 Write the names of any three charts provided by PowerPoint. 

	 ………………………………………………………………………………………

2.	 What is the use of the Table Styles? 

	 ………………………………………………………………………………………
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ENHANCING A PRESENTATION

A.	 Fill in the blanks using the hints given below:

	 Hints: Shading, Insert, Axis Titles, Chart Layouts, Legend Hints 

1.	 The Table option is present under the Tables group of the ……………………. tab.

2.	 ……………………. command is used to change the background of the table. 

3.	 Chart styles are listed in the ……………………. group of the Design tab. 

4.	 ……………………. is a key which shows the meaning of symbols and colours used 
in the chart. 

5.	 The ……………………. command is used to give titles of both x-axis and y-axis.

B.	 Write ‘T’ for true and ‘F’ for false.

1.	 We cannot give background colour in a table.� ………….

2.	 PowerPoint does not provide any tool to improve the appearance  
of a chart. � ………….

3.	 Plot area of a chart is the rectangular area bounded by the two axis. � ………….

4.	 The bar chart displays the data in the form of long rectangular rods also

	 called bars. � ………….

5.	 You cannot align text in a table. � ………….

C.	 Match the following:

1.	 Legend	 a.	 Value axis

2.	 X-axis	 b.	 shows the meanings of symbols and colours

3.	 Y-axis	 c.	 includes all objects and elements in a chart

4.	 Chart Area	 d.	 Category axis
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INTRODUCTION TO EXCEL 2016

A. 	 Tick ( ) the correct option.
1. 	 What is the intersection of a row and column called?

a.	 Row	 	 b.	 Column	

c.	 Cell	 	 d.	 None of these	

2. 	 A cell that appears highlighted with dark black border is called ............................ .

a.	 Active cell 	 	 b.	 Deleted cell 	

c.	 Main cell	 	 d.	 First cell	

B. 	 Label the components of MS Excel 2016 window.

C. 	 Fill in the blanks using the hints given below:

	 Hints:  =, 10,48,576

1.		 A formula starts with an …………………. sign.

2.	 A worksheet contains …………………. rows.
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INTRODUCTION TO EXCEL 2016

A. 	 Write ‘T’ for true and ‘F’ for false. 

1.	 By default, an Excel workbook contains 4 worksheets.� ……….…

2.	 Letters A to Z, AA to AZ are the Row headings.� ……….…

3.		 Rows are denoted by letters in a worksheet.� ……….…

B. 	 Answer the following questions:
1. 	  What is MS Excel?

	 ………………………………………………………………………………………

2.	 What is a formula?

	 ………………………………………………………………………………………

3.	 How will you enter data in a worksheet?

	 ………………………………………………………………………………………

4.	 What is a cell?

	 ………………………………………………………………………………………

C.	 Match the following:
1.	 Merge & Center button	 a.	 To move one screen up

2.	 Page Up	 b.	 Home tab

3.	 Ctrl+Home	 c.	 To move to the first cell of the topmost row.

Chapter-4



Grade:          Teacher’s Signature: 

WORKSHEET 1

 

c
la

ss
 5

Name: 

Roll No: 

Class:  Section:  Date: 

T uchpad
PLAY Ver. 2.1

EDITING IN EXCEL 2016

A.	 Define the following:

1.	 Formula Bar - ………………………………………………………………………..

	 ……………………………………………………………………………………….

2.	 Cell - …………………………………………………………………………………

	 ……………………………………………………………………………………….

3.	 Workbook - ……………………………………………………………………………

	 ………………………………………………………………………………………

B.	 Tick ( ) the correct option.
1.	 The currently selected cell that appears highlighted with dark black border is 

called ………………………. . 

	 a.	 Active cell	 	 b.	 Selected Cell	

	 c.	 Main Cell	 	 d.	 Name Box	

2.	 By default, how many sheets are there in a Workbook?

	 a.	 2	 	 b.	 4	

	 c.	 3	 	 d.	 1 	

3.	  How many rows are there in a worksheet? 

	 a.	 1048576 	 	 b.	 148576	

	 c.	 16384	 	 d.	 None of these	

C.	 Write the steps to create a new workbook in MS Excel.
Step 1	………………………………………………………………………………………

Step 2	………………………………………………………………………………………

Step 3	………………………………………………………………………………………

Step 4	………………………………………………………………………………………
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EDITING IN EXCEL 2016

A.	 Fill in the blanks using the hints given below:

	 Hints: Cell Styles, Select All, Insert, Merge & Center 

1.	 The ……………. button on the Home tab is used to add a column into a worksheet. 

2.	 We can apply a style on the cells by using the ……………. command on the Styles 
group under the Home tab.

3.	 We can select entire worksheet by clicking on the ……………. button.

4.	 We can use ……………. option in the Alignment group to combine two or more 
selected cells into a single cell. 

B.	 Write ‘T’ for true and ‘F’ for false.

1.	 We cannot select more than one cell at a time in an Excel worksheet.	 …………

2.	 We can format number in a cell. � ………….

3.	 We cannot merge two or more cells.� ………….

4.	 AutoFill allows user to automatically fill a number or text series.� ………….

5.	 The contents of a cell can be moved or copied to other cells.� ………….

C.	 Answer the following questions:

1.	 What is the use of Copy command on the Home tab? 

	 ………………………………………………………………………………………

2. 	 Which feature of MS Excel allows us to display multiple lines of text inside a cell?

	 	………………………………………………………………………………………
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INTERNET AND E-MAIL

A.	 Read the clues and answer the following:

1.	 It is an address of a web page over the Internet.

	 ………………………………………………………………………………….……

2.	 It is an Internet host computer that often store thousands of individual web pages.

	 ………………………………………………………………………………….……

3.	 It is a system of interconnected networks.

	 ………………………………………………………………………………….……

4.	 It is a collection of related web pages.

	 ………………………………………………………………………………….……
5.	 It is a software application designed to find hypertext documents on the web and 

then open the documents on the user’s computer.

	 ………………………………………………………………………………….……

B.	 Circle the correct option.

1.	 (Internet / E-mail) is a huge, cooperative community with no central ownership.

2.	 The seeds of the Internet were planted in (1959 / 1969).

3.	 (HTTP / WWW) is a large information system where you can surf and get information.

4.	 A collection of related pages is called (website / web browser).

5.	 A (web browser / hyperlink) is simply a part of the web page that is linked to a URL.

C.	 Name the different parts of the following email:

1. ...........................   2. ...........................
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INTERNET AND E-MAIL

A.	 Write the full forms of the following:

1.	 ARPA - ……………………………………………………………………………….

2. 	 HTTP - ……………………………………………………………………………….

3.	 WWW - ………………………………………………………………………………

4.	 NCSA - ……………………………………………………………………………….

5.	 URL - …………………………………………………………………………………

B.	 Tick ( ) the correct option.

1.	 E-mail can be defined as the process of exchanging ........................... electronically. 

a.	 Hardware 	 	 b.	 Instructions	

c.	 Messages 	 	 d.	 Information	

2.	 Which of the following fields is not available while writing a new email in Gmail?

a.	 To	 	 b.	 Cc	

c.	 Subject 	 	 d.	 New Message	

3.	 Which of these is used to show Sleeping expression emoticon?

a.	 (-_-)zzz	 	 b.	 (=_=)	

c.	 :$	 	 d.	 None of these	

C.	 Match the following:

1.	 Internet	 a.	 Software application

2.	 Collection of related pages	 b.	 Web address of a web page

3.	 Web browser	 c.	 A large computer network

4.	 URL	 d.	 Website
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CREATING SHAPES IN SCRATCH

A.	 Tick ( ) the correct option.
1.	 Which of the following command is used to draw circles and semicircles?

a.	 Repeat	 	 b.	 Turn	

c.	 Stamp	 	 d.	 None of these	

2.	 Which block is used to duplicate the sprite’s image onto the stage?

a.	 Pen up	 	 b.	 Stamp	

c.	 Clear	 	 d.	 Motion	

3.	 Which block is used to draw shapes?

a.	 Pen	 	 b.	 Control	

c.	 Motion	 	 d.	 None of these	

B.	 Identify the below figures and write their names.

1.  …………….… 3.  …………….…2.  …………….… 4.  …………….…

C.	 Fill in the blanks using the hints given below:
Hints: Motion, Set pen color to, Anti-clockwise direction

1.	 …………….…. block changes pen colour based on your choice from colour picker. 

2.	 The  turn degrees15  block will turn the Sprite in …………….…. by the specified 
number of degrees.

3.	 The Turn block is under the …………….…. blocks menu.
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CREATING SHAPES IN SCRATCH

A.	 Write ‘T’ for true and ‘F’ for false.
1.	 A hexagon has seven sides.					     …………….….

2.	 Control block is used to draw shapes.			   …………….….

3.	 We cannot draw shapes in scratch.			   …………….….

B.	 Match the following: 

1.	 stamp 	 a.	� To duplicate the sprite’s image onto the 
stage.

2.	 set pen color to 	 b.	 To put sprite’s pen up

3.	 pen up 	 c.	� To change the pen colour based on your 
choice from  colour picker.

C.	 Answer the following questions:
1.	 What is total sprite trip?

	 ………….…………………….………….………….…………………….…………

2.	 Which block is used to change the direction of the sprite? 

	 ………….…………………….………….………….…………………….…………

3.	 What is a regular polygon?

	 ………….…………………….………….………….…………………….…………
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CREATING A GAME IN SCRATCH

A.	 Tick ( ) the correct option.
1.	 Which block is used to run a set of instructions till a condition is satisfied?

a.	 Repeat Until      	 	 b.	 Forever	

c.	 Repeat	 	 d.	 Motion	

2.	 Which of the block is used to hold values?

a.	 Variables	 	 b.	 Operators	

c.	 Blocks	 	 d.	 None of these	

3.	 Operators blocks are colour-coded as ………….… .

a.	 blue      	 	 b.	 purple	

c.	 light-green	 	 d.	 black	

B.	 Identify and name the category in which these blocks appear:

1.	 ask and  waitWhat's your name? 			   ………….…………………

2.	 touching  color       ? 		  ………….…………………

3.	
repeat 10

		  ………….…………………			

C.	 Fill in the blanks using the hints given below:
Hints: Sensing, Conditional, Variables

1.	 The statements that are executed on the basis of decision take from a choice are 

called …………….…. statements.  

2.	 The blocks in the …………….…. category are colour-coded as light blue.

3.	 …………….…. are used to hold values.
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CREATING A GAME IN SCRATCH

A.	 Guess who am I?
1.		 I am a logical operator which gives the result true only if the  

two expressions are true.	�  ………….

2.	 I store the input given by the user.� ………….

3.	 I help the selected sprite to detect the presence of other sprites.� ………….

B.	 Answer the following questions:
1.	 What is looping?

	 ………….…………………….………….………….…………………….…………

2.	 Write the use of operator blocks.

	 ………….…………………….………….………….…………………….…………

3.	 Name two conditional statements.

	 ………….…………………….………….………….…………………….…………

4.	 How many relational operators are there in scratch?

	 ………….…………………….………….………….…………………….…………

C.	 Write ‘T’ for true and ‘F’ for false.

1.	 Escape block is used to hide the sprite from the stage.� ………….

2.	 The ‘if’ statement has three variants.� ………….

3.	 In Scratch, the variables can be created using Data blocks.� ………….
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